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Abstract

Questa nota descrive passo passo la procedura di layout di un amplificatore
operazionale in tecnologia da 0,35 micron utilizzando Cadence con 1’Hit-Kit 3.70 dell’AMS.
Viene confrontata la simulazione pre-layout con quella post-layout e viene dimostrato che con
un’accurata disposizione dei componenti le differenze tra le due simulazioni sono molto

piccole.
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1. INTRODUZIONE

Il pacchetto software comunemente utilizzato per la realizzazione di dispositivi full
custom, sia analogici che digitali, ¢ certamente Cadence [1].

I progetti si sviluppano a partire da uno Schematic Editor, dove si disegna il circuito, e
dall’ambiente di Layout su silicio. Un potente simulatore, poi, ¢ in grado di simulare sia lo
schematico che il layout e tutti i componenti parassiti.

Per la realizzazione dell’ASIC ¢ comunque necessario 1’utilizzo di un Kit di librerie di
componenti e PAD che rispettino le specifiche della tecnologia usata nel processo di lavorazione
del chip. Queste librerie vengono in genere fornite dalla fonderia che realizza il lavoro.

Noi abbiamo utilizzato Cadence Virtuoso Front to Back Design Enviroment 5.10.41, con
I’Hit-Kit 3.70 dell’AMS [2], e Linux Red Hat Scientific 3 come sistema operativo.

2. INIZIALIZZAZIONE DEL PROGETTO

La finestra CIW (Command Interpreter Windows) ¢ invocata all’avvio e rappresenta il
cuore del programma (Fig. 1). Da qui ¢ possibile avviare tutti i vari tool, gestire le librerie,
configurare il programma, inviare comandi e visualizzare i messaggi di sistema e di errore.

icfb - Log: /home/energico/CDS.log
File Tools Options HIT-Kit utilities Help | 1

END OF LOCAL CUSTOMIZATION.
Loading $HOME/. cdsinit personal file from . cdsinit file.
END 0OF USER CUSTOMIZATION.
END OF SITE CUSTOMIZATION.

mouse L: : E:
HIT-Kit: 3.70 Tech: c35b4c3 User: energico

Figura 1 - Command Interpreter Window

Da qui si parte per creare la libreria di progetto e per stabilire il file di tecnologia da
utilizzare.

2.1. CREAZIONE DI UNA LIBRERIA

Con la sequenza CIW > Tools - Library Manager compare la finestra del Library
Manager (Fig. 2a) che ¢ divisa in tre colonne. La prima a sinistra ¢ la libreria di progetto, che
puo contenere diversi schemi elettrici. Le Cell sono un unico schema elettrico che puo avere
diverse View (schematico, simbolo, layout, estratto).

Esistono sia librerie con nome in maiuscolo che in minuscolo. Le librerie in minuscolo,
come analogLib, fanno parte di Virtuoso e contengono componenti che possono essere simulati
ma non implementati sul silicio (generatori, impulsatori, riferimenti di tensione e anche capacita,
resistenze). Le librerie in maiuscolo fanno parte dell’Hit-Kit fornito dalla fonderia e contengono,
dunque, tutti i componenti implementabili (pmos, nmos, resistenze, capacita, pad, via).

Per creare la libreria di progetto e collegarla al file di tecnologia da utilizzare, la sequenza
Library Manager - File > New Library ci consente di impostare il nome della libreria (Fig. 2b)
e poi (Fig. 2c) di collegarla al file di tecnologia C35B4 che selezioniamo nella finestra
successiva (Fig. 2d).
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Figura 2 - Library Manager Window (2a); New Library Window (2b); Technology File
Window (2¢); Attach Window (2d).

3. CREAZIONE DI UNO SCHEMA ELETTRICO

Per creare un nuovo schematico si seleziona prima la libreria di lavoro, poi si inserisce il
nome del circuito nella casella Cell e il tipo di vista nella casella View. Le impostazioni vanno
confermate nella finestra Create New File (Fig. 3a), assicurandosi che alla voce Tool sia
selezionato Composer-Schematic.

Nel composer-Schematic (Fig. 3b) possiamo cominciare a disegnare il circuito.

Ok Cancel | Defaults Help : . e i i B B e e s
Library Name Articolo S e |
Cell Hame op_ang
View Name schematic
Tool Composer- Schematic

Library path file el
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Figura 3a — New File Window

3.1. MENU E BINDKEY

I menu, e i BindKey piu utilizzati nella realizzazione di uno schema sono: Add, per
inserire un componente con Istance [i]; per tracciare un Pin [p] o i collegamenti Wire [w]; Edit,



per editare [q], copiare [c], spostare [m], ruotare [tasto destro mouse], cancellare [Del]; Tools, da
qui si lanciano tutti tool, compreso quello di simulazione: Analog Enviroment.

3.2. POSIZIONAMENTO COMPONENTI

Disegniamo 'amplificatore operazionale, inserendo i componenti con Add = Istance, e
poi Browse per navigare le librerie e selezionare il componente (Fig. 4a) e collegandoli fra di
loro.

Selezioniamo nmos4 dalla libreria PRIMLIB, e poi cpoly (capacita), con la View
impostata su Symbol. E’ possibile ruotare, specchiare ed editare i parametri del componente
dalla finestra Add Istance.

Per creare i collegamenti fra i componenti, selezionato Add > Wire si attiva il comando
Wire. Quando si collegano fra loro due fili automaticamente viene creato un nodo. Non ¢
possibile collegare piu di due net su un unico nodo.
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Figura 4 — Add Istance Window(4a); Composer-Schematié (4b); Edit Object Propérty (4c)

Per editare le proprieta e i parametri dei componenti ¢ sufficiente selezionarli e premere il
tasto Q sulla tastiera. In alternativa selezionare Edit = Property. Nella finestra Edit Object
Property, in Fig. 4c, ¢ possibile editare tutti i parametri del componente selezionato (ad es. la W
e la L dell’ nmos4.

Con Add - Wire name & possibile assegnare un nome ad una determinata net, cosa utile
in fase di simulazione per identificare le net in base il nome da noi assegnato.

Nei punti del circuito che vanno a interfacciarsi con 1’esterno bisogna inserire i Pin che
nel caso dell’operazionale sono le due alimentazioni, i due ingressi ¢ 1’uscita. Con Add - Pin si
sceglie il nome dei pin e le direzioni che per il nostro circuito sono: VDD, VSS, IN+, IN- e OUT.

Si inseriscono tutti i componenti fino a ottenere lo schema in Fig. 5, e si salva col
comando Design > Check and Save.
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Figura 5 — Schema Amplificatore Operazionale

3.3. CREAZIONE DEL SIMBOLO

Infine creiamo il simbolo dello schema disegnato con Design = Create Cell View >
From CellView. Si aprira una finestra che chiede conferma dello schema di cui creare il simbolo
e il nome da assegnare a quest’ultimo (Fig. 6a). La finestra Symbol Generation Option ci
permette di indicare su quale lato del simbolo mettere i relativi pin ed, eventualmente, di fare
modifiche.

Una volta dato I’OK si aprira una nuova finestra con il simbolo del nostro circuito (Fig.
6a). In questa fase, con i comandi del menu Edit ¢ possibile modificare il disegno del simbolo
per rappresentarlo nel modo desiderato, come in Fig. 6b.
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Flgura 6-— Symbol Generatlon Optlon e Symbol Editor (6a); Symbol Edltor Wlndow (6b)



3.4. SIMULAZIONE DEL CIRCUITO

Adesso possiamo creare una nuova Cell inserendovi il simbolo appena creato, con il
comando Add > Istance, aggiungendo le alimentazioni e gli impulsatori (Fig. 7) e procedendo

con la simulazione del circuito.
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Figura 7 — Circuito di si-inuiﬁ-ziohe (7a); Analog Design Enviroment (7b); Choosing

Analyses (7¢)

Selezionando Tools =2 Analog Enviroments si avvia il tool di simulazione (Fig. 8a). Dal
menu Analyses impostiamo il tipo di simulazione (transiente, noise, dc, ac) e i parametri.
Avviamo la simulazione col comando Simulation > Netlist and Run e dal menu Result = Direct
plot scegliamo quali dati visualizzare, fra questi il Diagramma di Bode di Fig 8.
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Dal grafico notiamo che 1’amplificazione in bassa frequenza ¢ 77,28 dB e che il margine di fase

¢ di 56,14 gradi.



4. CREAZIONE DEL LAYOUT " e e
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Figura 9 — Layout generation Option

4.1. BINDKEY

I comandi del menu Edit ci permettono sia di spostare e ruotare i componenti che di
editarne le proprieta. I tasti di scelta rapida utili sono: MAIUSC + F per visualizzare tutti i layer;
CTRL + F per visualizzare soltanto i bordi esterni dei componenti; M per spostare i componenti;
F3 per attivare il menu contestuale che permette di modificare la direzione di spostamento dei
componenti (AnyAngle, orthogonal, diagonal, horizontal e vertical); Q per editare le proprieta
dei componenti; ecc.

4.2. PIAZZAMENTO DEI COMPONENTI
I componenti impostati appaiono come in Fig. 10.

X 1429 ¥:-102.4 (F) Select: 13 DRD: OFF dx: 23.1 dy: -55.3 Dist: 59.93 Cmd: Move

Tools Design Window Create Edit Verfy Connectivity Options Place Routing Migrate Compact HIT-KIT Utilities
&
&l

&
Y

Figura 10 — Importazione componenti

Il blocco rettangolare in basso ¢ la capacita di feedback, mentre quello in alto ¢ il MOS di
uscita Mp,. L’eccessiva lunghezza va sia a discapito della geometria del blocco che della
lunghezza dei collegamenti. Bisogna percid modificarne le dimensioni senza, ovviamente,



alterarne le caratteristiche elettriche. Selezioniamo la capacita e poi col tasto Q apriamo la
finestra Edit Istance Property per modificare i parametri del componente. Nel caso della capacita
impostiamo la lunghezza a 65um. Il programma modifica il valore della capacita, che dobbiamo
ripristinare a 3pF. Fatto cio, in automatico, otteniamo il nuovo valore della larghezza.

Per modificare la forma del mos Mp, lo selezioniamo e, dopo aver premuto su Q,
andiamo a modificare il numero di Gates del mos. Questa modifica lascia invariate le sue
caratteristiche elettriche. Il risultato ottenuto sara cosi quello di Fig. 11.

Il comando Connectivity = Show Incomplete Nets visualizza le net da collegare. Con
SelectAll e quindi Apply compaiono tutti i collegamenti da realizzare. Le net scompaiono a

collegamento avvenuto.

Bisogna adesso piazzare i componenti in posizione ottimale per effettuare i collegamenti.
La finestra LSW presente gia all’apertura del Layout Editor consente di selezionare il layer (ad

es. Metal, Poly, o le diffusioni di tipo n o p).

I mos devono essere vicini, di modo che abbiano caratteristiche simili € non risentano
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Figura 11 - Ottimizzazione delle dimensioni
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delle possibili tolleranze del
processo di produzione special-
mente se in configurazione a
specchio. I collegamenti devono
essere effettuati in metal e non in
poly, perché questo presenta
un’elevata resistenza.

Nel caso in cui un mos
abbia il collegamento di substrato
allo stesso potenziale del source,
¢ possibile creare in automatico il
contatto selezionando la voce
Substate Contact dalla finestra
Edit Istance Properties. In caso
contrario il contatto va creato
separatamente e collegato.

4.3. SBROGLIO

Per lo sbroglio selezio-
niamo il layer METI nella fine-
stra LSW. A sinistra della finestra
di disegno il menu ci permette di
accedere alle funzioni: Rectan-
gle, per creare un rettangolo il cui
riempimento dipende dal layer
selezionato su LSW, Poligon, per
tracciare un poligono, Path, per
creare una pista delle dimensioni
desiderate, e al Ruler, un righello
molto utile per misurare le
distanze fra piste, pad e cosi via
(@il righello si attiva anche pre-
mendo K; MAIUSC + K I
elimina).



Nello sbroglio bisogna far riferimento alle Design Rules (CMOS C35B4
dell’ AustrianMicrosystem), che definiscono 1’insieme delle regole di disegno, le distanze
minime e massime, le dimensioni, le forme dei pad, le correnti massime.

Per passare da un metal layer ad un altro si usa il BindKey O, e si ha accesso a un menu in
cui possiamo scegliere il tipo di pad da usare. I pad sono definiti dalla tecnologia costruttiva e
non sono quindi modificabili.

In Figura 13 ¢ possibile osservare il risultato finale. Si possono vedere i pin di ingresso
IN- e IN+ sulla sinistra, le due alimentazioni VDD e VSS rispettivamente sopra e sotto e 1’uscita
a destra del blocco. Tutt’intorno al blocco abbiamo disposto un Guard Ring che isola il circuito
dagli altri adiacenti che si troveranno nell’intero chip e che limita le correnti di leakage.
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Figura 13 — Layout finale
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Lo sbroglio si controlla con Verify =
DRC. Nella finestra del DRC, in Figura 14,
dobbiamo solo che verificare che si faccia Chacking Malhed & 834 - eramenleal - BiBr Wi DRUInEztion
correttamente riferimento al Rule File, che nel o e ———
nostro caso ¢ divaDRC.rul, e alla Rule Library
collegata alla libreria relativa la tecnologia in
uso. Una volta dato I’OK verra eseguito il
controllo di conformita del disegno. Alla fine del
processo nella finestra CIW vediamo un report
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¢ completo.
Figura 14 - DRC Window



S. SIMULAZIONE POST LAYOUT

Una delle fasi piu importanti e interessanti del flusso di progetto ¢ la simulazione post
layout con cui simuliamo tutti i parassiti presenti nel chip, dovuti alle caratteristiche fisiche dei
componenti e dei collegamenti.

La simulazione post layout pud essere eseguita sia di un circuito con i PADs che senza.
Prendiamo, quindi, il layout dell’op-amp e generiamo i file per 1’estrazione dei parametri
parassiti attraverso il comando Verify = Extract. Il campo Switch Name deve essere impostato
su capall e Rules Library sulla tecnologia in uso TECH_C35B4 (Fig. 18). Premendo su OK viene
generato una nuova View Extracted del circuito, sulla quale sono riportati i componenti parassiti.
Selezioniamo adesso Verify = LVS per la creazione del file necessario per la simulazione post
layout. Dopo aver selezionato lo schematic e 1’extracted del circuito eseguiamo il comando Run
e, dopo aver verificato eventuali errori, Build Analog (Fig. 18b) per la creazione del file
analogExtracted.
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Figura 18 — Extractor Window (18a); LVS Window (18b).

Per la simulazione post layout, apriamo lo schematico e lanciamo la simulazione con Tools 2>
Analog Enviroments. Poi dal menu Setup = Enviroment Option, impostiamo la stringa Switch
View List su: spectre analog_extracted e ————
cmos_sch schematic (Fig. 19). Dopo aver OF | Cancel | Detalts Aty Help
applicato le modifiche lanciamo la
simulazione con Netlist and Run. Questa
volta il simulatore terra conto del file Paranaior Basgs Chacking i [Jsasostonselmeafapsstas fatn g, e
analogExtracted e quindi di tutti i ety et o

componenti parassiti rilevati. Con Result

Sowribrh e Lt gpectoe analog extractad [orma_sch schawatic

Thog Viewr Lisl spactrn shdl waralagy

Print Crvenients
= Direct plot > AC Gain & Phase et L ot
visualizziamo il diagramma di Bode del ot ot o -
circuito e lo confrontiamo col risultato T
ottenuto  dalla  simulazione  dello e T e
schematico (Fig. 20). [ e kgt Pl ¥

Figura 19 — Simulazione analog_extracted
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Il risultato ottenuto ¢ molto prossimo a quello ideale. Cio¢ abbiamo un guadagno in DC
di 78,03 dB e un margine di fase di 52,39 gradi. Qualora invece le differenze siano tali da non
rientrare in una tolleranza accettabile bisogna procedere con modifiche al layout o allo schema.

6. AGGIUNTA DEI PADs

Dobbiamo adesso aggiun-
gere i PAD sui quali verra eseguito
il bonding. Questi PAD vanno
prima aggiunti nello schema
elettrico.

Dal  Library  Manager
creiamo una nuova Cell e la
chiamiamo Op_amp_PIN e una
nuova View schematic. Copiamo
in questa View il circuito Op_amp
e aggiungiamo i PAD (Fig. 15). 1
PAD si trovano nella libraria
PADs, e sono specifici per VDD,
GND, I/0.
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Avendo aggiunto i pin siamo in presenza di un nuovo schematico e, per procedere con la
creazione del layout, vanno rieseguite le operazioni descritte al paragrafo 4. per la creazione di

un nuovo layout.

Dopo aver eseguito i collegamenti fra circuito op_amp e PADs (Fig. 16a), questi ultimi
vanno collegati tra di loro (Fig. 16b). In particolare, ogni PAD ha collegamenti verso le

alimentazioni di riferimento.
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Flgura 16 Layout con PADs (16a); Layout con strutture (16b).

6.1. SCELTA DEL PACKAGE E BONDING

L’ultimo passo ¢ la scelta di un package e del bonding, cio¢ dei collegamenti tra i PADs
sul silicio e quelli del package. Possiamo scegliere il Package dalla libreria LEADFRAMES. Dal
CIW selezioniamo HIT-KIT Utilities = Bonding Diagram Editor. Nella finestra Chip Bonding

(Fig. 17) selezionare il Leadframe
T« Scelto, il chip e la libreria di
= o . destinazione del Bonding Diagram.
Cliccando su BondingAbstract viene
creato un nuovo file in cui sono
visibili solo i PADs del chip. Infine
R =TT op_ap I TH A— con Place si apre una nuova finestra
con il package scelto e il chip al
centro. In questo file dobbiamo
Bund Methos @ Palist _ FaliwwingFrstioms eseguire le piste di collegamento fra
i PADs del chip e quelli del package
_| attraverso il comando Path.

Lehrmrg o CrlBrens Wi Maome

Lendirome | LEADEREAEY aza- Layout] Emr—

Ennsng Dasgr, hrticola® op_msp P I honding [ ———

Artion Bonniigfhatract Place Bond  Check Wrile-Finlisl Wrile-Def  Delele Bonding

L
Figura 17 — Chip Bonding Window

6.2. SIMULAZIONE POST LAYOUT CON PADs

E’ necessario adesso procedere con una nuova simulazione post layout del circuito con i
PADs. Generiamo le View extracted e analogExtracted come descritto al paragrafo 5., poi
creiamo un nuovo circuito di simulazione come fatto al punto 3.4., e infine rieseguiamo la
simulazione. I risultati ottenuti sono di 78,03 dB di guadagno alle basse frequenze e un margine
di fase di 52,39 gradi.

7. CREAZIONE DEL file.GDS

Per creare il file di progetto da inviare alla fonderia selezioniamo dal CIW File > Export
—> Stream, poi selezioniamo il layout da realizzare e OK.



8. CONCLUSIONI

Questa nota ha mostrato il flusso di progetto per un amplificatore operazionale full
custom in tecnologia da 0.35 micron.

Si ¢ dimostrato che effettuando un accurato layout, le prestazioni del circuito sono
prossime a quelle dello schematico.
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